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This Software License shall govern the licensing of all software provided to licensee by Bay Networks (“Software”). 
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permission to use the Software at licensee’s facility, and who have agreed in writing to use the Software only in 
accordance with the restrictions of this license.

7. Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated into 
Bay Networks products shall have the right to enforce the provisions of this license against licensee.

8. Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual 
property or restricted rights notice within or affixed to any Software and shall reproduce and affix such notice on 
any backup copy of Software or copies of software resulting from modification or combination performed by 
licensee as permitted by this license.

Note:  This is Bay Networks basic license document. In the absence of a 
software license agreement specifying varying terms, this license — or the 
license included with the particular product — shall govern licensee’s use of 
Bay Networks software.
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Bay Networks Software License (continued)

9. Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note: For 
licensees in the European Community, the Software Directive dated 14 May 1991 (as may be amended from time 
to time) shall apply for interoperability purposes. Licensee must notify Bay Networks in writing of any such 
intended examination of the Software and Bay Networks may provide review and assistance.]

10. Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site 
Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation. This 
right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s network. 

11. This license will automatically terminate upon improper handling of Software, such as by disclosure, or Bay 
Networks may terminate this license by written notice to licensee if licensee fails to comply with any of the 
material provisions of this license and fails to cure such failure within thirty (30) days after the receipt of written 
notice from Bay Networks. Upon termination of this license, licensee shall discontinue all use of the Software 
and return the Software and Documentation, including all copies, to Bay Networks.

12. Licensee’s obligations under this license shall survive expiration or termination of this license.
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About This Guide

If you are responsible for activating a router or BNX platform on your IP network, 
this guide can help you complete the Quick-Start installation procedure to

• Configure the initial IP network interface

• Install Site Manager on your workstation or PC 

You use Site Manager to remotely configure and manage routers and BNX 
platforms over the network.

• Use Site Manager to create a pilot configuration 

When you finish the procedure, the router or BNX platform will actively route IP 
traffic on your network.

• Upgrading Routers from Version 5 to Version 10.0

• Upgrading Routers from Version 7-9.xx to Version 10.0

• BNX 6.0 Release Notes

Audience

Written for system and network managers, this guide describes how to initially 
configure your Bay Networks router or BNX platform on the IP network and 
install Site Manager on your hardware platform. This guide does not apply to 
AN™ routers. It covers local Quick-Start procedures for the ASN™ router. For 
ASN network booting information, refer to Connecting ASN Routers and BNX 
Platforms to a Network.

Note: Use this guide for first-time installations. For upgrades, use only those 
sections of this guide that are referred to in the appropriate upgrade guide:
xiii
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Before You Begin

Before using this guide, you must install the router. Refer to the installation 
manual that came with your router for instructions. Also, review the Read Me 
First and Release Notes documents for changes to the Quick Start instructions.

Bay Networks Customer Support 

Bay Networks provides live telephone technical support to our distributors, 
resellers, and service-contracted customers from two U.S. and three international 
support centers. If you have purchased your Bay Networks product from a 
distributor or authorized reseller, contact the technical support staff of that 
distributor or reseller for assistance with installation, configuration, 
troubleshooting, or integration issues.

Customers also have the option of purchasing direct support from Bay Networks 
through a variety of service programs. The programs include priority access 
telephone support, on-site engineering assistance, software subscription, hardware 
replacement, and other programs designed to protect your investment.

To purchase any of these support programs, including PhonePlus™ for 24-hour 
telephone technical support, call 1-800-2LANWAN. Outside the U.S. and 
Canada, call (408) 764-1000. You can also receive information on support 
programs from your local Bay Networks field sales office, or purchase Bay 
Networks support directly from your reseller. Bay Networks provides several 
methods of receiving support and information on a nonpriority basis through the 
following automated systems.

CompuServe

Bay Networks maintains an active forum on CompuServe. All you need to join us 
online is a computer, a modem, and a CompuServe account. We also recommend 
using the CompuServe Information Manager software, available from 
CompuServe.

The Bay Networks forum contains libraries of technical and product documents 
designed to help you manage and troubleshoot your Bay Networks products. 
Software agents and patches are available, and the message boards are monitored 
by technical staff and can be a source for problem solving and shared experiences.
xiv
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Customers and resellers holding Bay Networks service contracts can visit the 
special libraries to acquire advanced levels of support documentation and 
software.

To open an account and receive a local dial-up number, call CompuServe at 
1-800-524-3388 and ask for Representative No. 591.

• In the United Kingdom, call Freephone 0800-289378.

• In Germany, call 0130-37-32. 

• In Europe (except for the United Kingdom and Germany), call 
(44) 272-760681.

• Outside the U.S., Canada, and Europe, call (614) 529-1349 and ask for 
Representative No. 591, or consult your listings for an office near you.

Once you are online, you can reach our forum by typing the command GO 
BAYNETWORKS at any ! prompt.

InfoFACTS

InfoFACTS is the Bay Networks free 24-hour fax-on-demand service. This 
automated system contains libraries of technical and product documents designed 
to help you manage and troubleshoot your Bay Networks products. The system 
can return a fax copy to the caller or to a third party within minutes of being 
accessed.

World Wide Web

The World Wide Web (WWW) is a global information system for file distribution 
and online document viewing via the Internet. You need a direct connection to the 
Internet and a Web Browser (such as Mosaic or Netscape).

Bay Networks maintains a WWW Home Page that you can access at http://
www.baynetworks.com. One of the menu items on the Home Page is the 
Customer Support Web Server, which offers technical documents, software 
agents, and an E-mail capability for communicating with our technical support 
engineers.
xv
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How to Get Help

For additional information or advice, contact the Bay Networks Technical 
Response Center in your area:

United States  1-800-2LAN-WAN
Valbonne, France  (33) 92-966-968
Sydney, Australia  (61) 2-903-5800
Tokyo, Japan  (81) 3-328-005

Conventions

This section describes the conventions used in this guide:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command. Example: if 
command syntax is ping <ip_address>, you enter ping 
192.32.10.12

arrow character (➔) Separates menu and option names in instructions. 
Example: Protocols➔AppleTalk identifies the 
AppleTalk option in the Protocols menu. 

bold text Indicates text that you need to enter and command 
names in text. Example: Use the dinfo command. 

italic text Indicates variable values in command syntax 
descriptions, new terms, file and directory names, and 
book titles.

quotation marks (“ ”) Indicate the title of a chapter or section within a book.

screen text Indicates data that appears on the screen. Example: Set 
Bay Networks Trap Monitor Filters

vertical line (|) Indicates that you enter only one of the parts of the 
command. The vertical line separates choices. Do not 
type the vertical line when entering the command.

Example: If the command syntax is 

show at routes | nets, you enter either 
show at routes or show at nets, but not both.
xvi
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Ordering Bay Networks Publications

To purchase additional copies of this document or other Bay Networks 
publications, order by part number from Bay Networks Press™ at the following 
numbers. You may also request a free catalog of Bay Networks Press product 
publications.

Phone: 1-800-845-9523
FAX - U.S./Canada: 1-800-582-8000
FAX - International: 1-916-939-1010

Acronyms

AFN Access Feeder Node

ALN Access Link Node

ASN Access Stack Node

BCN Backbone Connector Node

BLN Backbone Link Node

BOOTP Bootstrap Protocol

CN Concentrator Node

FTP File Transfer Protocol

FDDI Fiber Distributed Data Interface

LN Link Node

NIC network interface card

NVFS Non-Volatile File System

OSI Open Systems Interconnection

QENET Quad Ethernet Link Module

RIP Routing Information Protocol

RISC Reduced Instruction Set Chip

SNMP Simple Network Management Protocol

TCP/IP Transmission Control Protocol/Internet Protocol

TFTP Trivial File Transfer Protocol
xvii





                      
Chapter 1
Overview of Quick-Start

This manual describes the Quick-Start procedure to locally boot your router or 
BNX platform and initially configure it on the IP network. To complete the Quick-
Start procedure, you follow these steps: 

1. Complete Quick-Start prerequisites.

Complete the following prerequisites before you begin the Quick-Start 
procedure.

a. Review whether Quick-Start procedures apply to your product.

Table 1-1 shows the Bay Networks routers with Quick-Start procedures 
covered in this manual. This manual does not apply to AN routers. AN 
routers have similar Local Boot procedures that are covered in their 
administrative manuals.

Table 1-1. Routers with Quick-Start Procedures

Bay Networks Router or BNX Platform

Access Feeder Node (AFN®)

Access Link Node (ALN)

Access Stack Node (ASN)

Backbone Concentrator Node (BCN®)

Backbone Link Node (BLN®)

Concentrator Node (CN®)

Link Node (LN®)
1-1
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b. Review Release Notes.

Review the release notes in this version’s documentation for new 
information about installation and configuration.

c. Install the router or BNX platform.

Install the router or BNX platform at your site. Refer to the installation 
manual that came with the router. 

d. Understand ASN terminology.

To Quick-Start an ASN, you need to understand some ASN terminology. 
Certain terms have different meanings for the ASN than for other Bay 
Networks routers or BNX platforms.

Each ASN unit is a separate node. You can connect as many as 4 nodes 
together into an ASN stack. Site Manager treats the combined nodes in an 
ASN stack as a single router.

The networking hardware modules in an ASN are called net modules. (In 
other Bay Networks routers and BNX platforms, these are link modules.) 
In an ASN, the term slot refers to the main processor module in each ASN 
node. (For Bay Networks routers and BNX platforms other than the ASN, 
the slot is where the link module resides.) Each ASN slot contains one to 
four net modules.

When you configure the ASN (or ASN stack), you identify the location of 
a net module by specifying: 

• The slot that contains the net module and 

• The module position where the net module resides

The ASN slot ID identifies the slot number. You set the slot ID using the 
slot ID dial on the rear panel of each ASN node. The modules positions 
are numbered 1 through 4 in each slot. For more information, refer to 
Installing and Maintaining ASN Routers and BNX Platforms.

2. Fill out the Network Information Worksheet.

Complete the Network Information Worksheet (Chapter 2) to assemble the 
information you need to Quick-Start the router or BNX platform (for 
example, the IP address and subnet mask of the router’s initial IP network 
interface). 
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3. Connect a PC or ASCII console to the router.

Connect a PC or a terminal to the router’s or BNX platform’s console port to 
view the Technician Interface (Chapter 3).

4. Connect to the IP network.

Connect a cable between the router or BNX platform and the IP network 
(Chapter 4).

5. Establish a Technician Interface session.

Use the Technician Interface, Bay Network’s command-line interface, to enter 
commands to run the Quick-Start installation script on the router (Chapter 5). 

6. Run the Quick-Start installation script.

Run Quick-Start to establish an initial IP network interface between the router 
or BNX platform and the workstation from which you’ll manage the router 
(Chapter 6).

7. Install Site Manager.

Install the Bay Networks Site Manager program on a PC or workstation 
located on the IP network. Site Manager uses Simple Network Management 
Protocol (SNMP) and Trivial File Transfer Protocol (TFTP) to communicate 
with the router or BNX platform so you can remotely configure and manage 
the router. 

Follow the instructions in the appropriate chapter to install the Site Manager 
software on a

— PC (Chapter 7)

— SPARCstation (Chapter 8)

— RS/6000 (Chapter 9)

— HP 9000 (Chapter 10)

Note: BNX Site Manager does not run on the HP 9000 workstation.
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8. Use Site Manager to create a pilot configuration.

Once you’ve installed Site Manager on a workstation, you can configure the 
router or BNX platform remotely by

— Creating a simple pilot configuration file

— Transferring the configuration file to the router

— Booting the router with pilot configuration

Creating the pilot configuration file (Chapter 11) completes the Quick-Start 
procedure described in this manual. 

To refine your configuration file to meet your specific network needs, refer to 
Configuring Routers or Configuring Customer Access and Trunks (BNX 
Software) and the appropriate protocol configuration manuals. 
1-4



           
Chapter 2
Filling Out the Network Information Worksheet

You fill out a Network Information Worksheet to refer to when you perform the 
Quick-Start installation script (install.bat) as described in Chapter 6. (See 
Appendix A for a sample installation script.)

The installation script prompts you for network information to connect the router 
or BNX platform to the IP network. The worksheet contains space for the advance 
information you will need when running install.bat. 

Use only the portions of the worksheet that apply to your network requirements. 
For example, if you are not enabling OSPF on the IP interface, pass over any 
questions that pertain to OSPF.

Many steps in the installation script suggest default values. Accept the default 
values unless you have a reason to make a change.

Some steps are optional for your network requirements. For example, local PAP 
passwords are optional with PPP. Also, if you don’t run optional features such as 
FTP or Telnet, your router will be more secure and use less memory and 
processing overhead.

The examples on the Network Information Worksheet reflect information from the 
sample network in Figure 2-1.

Note: Contact your network administrator for assistance in selecting 
worksheet options. AN and ANH™ routers are not covered by this worksheet.
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Figure 2-1. Sample Network Used In Worksheet Examples

0 IConnect a PC or
ASCII console  locally
to view  the Technician
Interface and run the
Quick-Start installation
script, install.bat.

Bay Networks  router or BNX platform

Console port in
Slot 1 of AFN, FN, LN,
ALN, CN, BLN, or ASN
or in Slot 7 of BCN

IP Address= 192.32.10.12

Use a Site Manager
workstation to manage
the router or BNX platform
remotely.

Corporate IP network

Connect the router or BNX
platform to the IP network.
This router connects from a
QENET Link Module
in Slot 2 using XCVR1
(Ethernet Connector 1)

IP = 192.168.125.34
Subnet Mask = 255.255.255.0

,
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Filling Out the Network Information Worksheet
Table 2-1. Network Information Worksheet 

Requested Information Example Your Information

Physical Connector Information

Enter the slot number containing the link module that 
provides the initial IP network interface (this module can 
reside in any slot that is designated for link module 
support).

Note: You also provide the module number for the ASN 
(example - Module1).

2 QE/NF

Number of the connector (port) providing the initial IP 
network interface.

1. XCVR1

Circuit Information

Enter the number of the circuit name. 1. E21

IP Interface Configuration Information

IP address of this initial network interface. 
(Advanced users only – install.bat supports unnumbered 
interfaces.)

192.168.125.34

Subnet mask address of this initial network interface (in 
dotted decimal notation).

255.255.255.0

Does this interface connect to the same local area 
network (LAN) as the Site Manager workstation?

No

IP Routing Protocol Information

IP Routing Protocol to configure to manage this router 
remotely. This is necessary only if you answered No to 
the previous question.

See the following sections for details on the IP Routing 
Protocol you choose to configure.

RIP

RIP Configuration Information

Should RIP listen to the default route to the network or 
subnet where Site Manager is located?

Yes

(continued)
2-3



Quick-Starting Routers and BNX Platforms
OSPF Configuration Information

OSPF Router IP Address. 192.32.156.7

OSPF Area Address. 0.0.0.0

Enable Simple Password Authentication? No

MTU size for OSPF packets (Default, Ethernet Size, 
User-defined MTU).

Default

OSPF interface type (Broadcast, NBMA, or Point to 
Point, Point to Multipoint, Point to Multipoint [std]).

Note: Match to the interface type. The interface type, 
Hello Interval, and Dead Interval must match the current 
OSPF configuration of the network.

Broadcast

Hello interval (in seconds). 10

Router dead interval (in seconds). 40

Router priority. 1

Poll interval. 20

If you are configuring OSPF neighbors, what is the IP 
address for each neighbor? 

Note: Neighbors are defined only if the OSPF interface 
type is NBMA. 

Not applicable. Sample 
format:
192.32.156.8
192.32.156.9

Static Route to Site Manager Configuration Information

Destination network. 192.32.90.0

Destination network mask. 255.255.255.0

Next-hop address that is in the same subnet as the initial 
IP interface.

192.32.4.99

Miscellaneous Information

Set SNMP Community Management? No

Default volume where TFTP transactions will take place. 2

Enable FTP? Yes

Default volume where FTP transactions will take place. 2

Enable TELNET? No

(continued)

Table 2-1. Network Information Worksheet (continued)

Requested Information Example Your Information
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Site Manager Workstation Information

IP address of the workstation on which the Site Manager 
software will be installed. This information is requested 
when the installation is tested at the end of the 
procedure.

192.32.10.12

WAN Information
The following information about enabling Frame Relay, PPP, and SMDS from the installation script is for 
experienced users only. Normally these protocols are implemented from Site Manager on an additional 
interface.

Frame Relay Information 
(To enable Frame Relay on a synchronous connector on this initial IP interface)

Enable Frame Relay on the interface? Yes

Management protocol that communicates with the 
Frame Relay network.

LMI

DLCI addressing types. ADDR Q.922

Frame Relay address field length. 2 bytes

Frame Relay PVC ID. 30

PPP Information
(To enable PPP on a synchronous connector on this initial IP interface)

Enable PPP on the interface? Yes

IP address of peer connection. 192.32.4.2

Enable PPP Echo protocol? Yes

Number of seconds between transmission of echo 
requests.

10

Acceptable loss of Echo-Reply packets. 3

Enable local authentication protocol? Yes

Local PAP ID for this interface. 192.32.4.1

Local PAP password (optional). lpwd

Authentication protocol enabled on remote peer? Yes

Remote peer PAP password. rpwd

Enable Link Quality Reporting (LQR) protocol? Yes

(continued)

Table 2-1. Network Information Worksheet (continued)

Requested Information Example Your Information
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Enable use of remote peer’s LQR timer? Yes

Minimum acceptable percentage of inbound packets. 90

Minimum acceptable percentage of outbound packets. 90

SMDS Information 
(To enable SMDS on a synchronous connector on this initial IP interface)

Enable SMDS on the interface? Yes

Individual address. C1617555433FFFF

Group address. E16175556667FFFF

ARP address. E16175550000FFFF

Table 2-1. Network Information Worksheet (continued)

Requested Information Example Your Information
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Chapter 3
Connecting a PC or ASCII Console

You connect to the router or BNX platform locally, with a PC or ASCII console, 
so you can run the Technician Interface and start the Quick-Start procedure. 

Connecting a PC

Connect your PC to the router or BNX platform as follows:

1. Set the communications parameters in the Terminal program that comes 
with Microsoft Windows or other terminal-emulation program. 

a. From Windows, open the Terminal program in the Accessories group.

b. Double-click on the Terminal icon.

c. Select Settings➔Terminal Emulation.

d. Click on the DEC VT100 (ANSI) option and click on OK.

e. Select Settings➔Communications.

f. Set the communications options as follows:

— Baud rate = 9600

— Data bits = 8

— Stop bits = 1

— Parity = none

— Flow control = Xon/Xoff

g. Click on the COM port you want to connect to the router or BNX 
platform, and click on OK. 

COM ports usually have a 9-pin female or a 25-pin female connection.
3-1



Quick-Starting Routers and BNX Platforms
h. Select Settings➔Terminal Preferences.

i. Turn off the Use Function, Arrow, and Control Keys for Windows 
default option so that you can use keyboard combinations when 
running the installation script.

j. Select File➔Save As.

k. Type the name of a new file in which to store the communications 
settings, and click on OK.

l. Select File➔Open.

m. Select the file you just named and click on OK.

2. Connect the cable from the console port of the router or BNX platform to 
the COM port you selected in the terminal emulation program. 

BCN, BLN, CN, and LN routers have a 25-pin male console port. ASN and 
AFN routers have a 9-pin male console port. Refer to the installation book 
that came with your router or BNX platform for more information.

3. Turn on the router to complete the internal diagnostics and startup.

When the router or BNX platform boots, the screen displays the Technician 
Interface Login prompt.

Connecting an ASCII Console

Connect an ASCII console (terminal) to the router or BNX platform as follows:

1. Set the operating parameters of the ASCII console as follows:

• Baud rate = 9600

• Stop bits = 1

• Parity = none

• Data bits = 8

Note: If you do not deselect the button for Use Function, Arrow, and 
Control Keys for Windows, you will not be able to use keyboard 
combinations such as Control-C when running the installation script.

Note: While you can run the Technician Interface with a local connection, to 
manage the router or BNX platform with Site Manager on a PC, you must 
connect the PC to the IP network.
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2. Connect the cable from the ASCII console to the router or BNX platform. 

BCN, BLN, CN, and LN routers have a 25-pin male console port. ASN and 
AFN routers have a 9-pin male console port. Refer to the installation guide 
that came with your router or BNX platform for more information.

3. Power on the router or BNX platform to complete the internal 
diagnostics and startup.

When the router or BNX platform boots, the screen displays the Technician 
Interface Login prompt.
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Chapter 4
Connecting to the IP Network

When you ordered your router or BNX platform, you also ordered a cable to 
connect the router or BNX platform to the IP network. Connect it using the 
following procedure:

1. Connect the cable to your router or BNX platform.

Table 4-1 gives the standard ports (also called connectors) for initially 
connecting the router or BNX platform to the IP network.

You can configure any port on a router or BNX platform for the initial IP 
connection by modifying the connection port in the Quick-Start installation 
script described in Chapter 6.

For information on the location of the port on your router or BNX platform, 
refer to the installation manual that came with your router or BNX platform.

2. Connect the cable to the IP network.

The connection depends upon your LAN or WAN configuration.

Table 4-1. Initial Connection Port to the IP Network

Bay Networks Router or BNX 
Platform

Default Connection Port

AFN/ES XCVR1 port

AFN/TS MAU1 port

ASN Any port on any net module, excluding the Stack 
Packet Exchange (SPX) Module

FN, ALN, LN, CN, BLN, BCN First port on the first link module (Slot 2 except 
BCN)
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For general information about cables, refer to Cable Guide for Routers and 
BNX Platforms.
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Chapter 5
Establishing a Technician Interface Session

Use the Technician Interface, the router or BNX platform’s command-line 
interface, to enter commands to run the Quick-Start program. Establish a 
Technician Interface session as follows:

1. At the Login prompt, enter 

Manager

The screen displays the slot where the Technician Interface is running, followed 
by the $ prompt, showing that you are logged in (Figure 5-1).

Figure 5-1. Technician Interface Screen

Note: The Technician Interface is case-sensitive; that is, the command 
Manager is not the same as manager. 

Bay Networks, Inc. and its Licensors.
Copyright 1992, 1993, 1994, 1995, 1996. 
All rights reserved.

> Login: Manager

>  Welcome to the Backbone Technician Interface

[2:1]$

  

Technician Interface
running on Slot 2,
Console Port 1
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2. For AFN, ASN, BLN, or BCN routers or BNX platforms, proceed to 
Chapter 6 to run the installation script.

3. For ALN, FN, LN, or CN routers, perform the steps below.

a. Enter the backplane command: 

backplane <router_type>

<router_type> is FN, LN, or CN. If you have an ALN, use LN as your 
<router_type>.

Example

backplane LN 

b. Boot the router by entering

boot

You must boot the router after issuing the backplane command.

c. Log in again as Manager when the Login prompt appears.

d. Proceed to Chapter 6 to run the installation script.
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Chapter 6
Running the Quick-Start Installation Script

Run the Quick-Start installation script to establish an initial IP network interface 
between the router or BNX platform and the Site Manager workstation from 
which you’ll manage the router or BNX platform.

To create the initial IP interface you need to

• Understand the router or BNX platform’s file system.

• Review the Quick-Start installation files.

• Boot the router or BNX platform with the ti.cfg file (a special booting file that 
initializes the router or BNX platform without pre-existing configuration).

• Run the Quick-Start installation script (install.bat) once, to configure the 
initial interface.

The Quick-Start installation script prompts you to enter the network information 
that dynamically configures the initial IP interface. You configure subsequent 
interfaces with Site Manager, Quick2Config, or other router management 
software.

Understanding the Router or BNX Platform’s File System

Your router or BNX platform stores installation files on memory cards. The Non-
Volatile File System (NVFS) running in the router or BNX platform reads and 
writes to the memory cards for file storage. Some older models also have disk 
drives with the Disk Operating System (DOS), but installation files for this release 
are not distributed on disks. Call the Bay Networks Technical Response Center for 
information on updating to a memory card system.
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Reviewing the Installation Files

After establishing the Technician Interface session, you are ready to display the 
Quick-Start installation files and verify that they are available: 

1. Find the memory card location.

Identify the slot where the router or BNX platform’s memory card (volume) 
resides by typing

dinfo

The Technician Interface interface displays a table showing the memory 
card’s slot and memory statistics (Figure 6-1). BCNs and BLNs may contain 
multiple memory cards — 1 memory card per slot. 

Figure 6-1. Sample NVFS dinfo Display

2. Display the names of the files in the volume (Figure 6-2) by typing

dir <slot_number>:

<slot number> is the memory card’s slot. Include the colon (:) after the slot 
number as part of the command string 

$ dinfo

VOL     STATE      TOTAL SIZE    FREE SPACE     CONTIG FREE SPACE

2:    FORMATTED     4194304       1458420           1458420

 $

The volume resides in the slot indicated.
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Figure 6-2. Sample Installation Files

3. Verify that the directory lists the Quick-Start installation files shown in 
Table 6-1 or their equivalents.

Table 6-1. Quick-Start Installation Files

Filename File Type

file_name.exe (example – bn.exe)
or ace.out

The bootable router or BNX platform 
software image (see Table 6-2)

config Configuration file

debug.al Alias file

install.bat Installation script file

ti.cfg Initial configuration file

Note: Other files may be in the directory.

$ dir 2:
 Volume in volume 2: is
 Directory of 2:

File Name             Size    Date     Day      Time
------------------------------------------------------
config                7132  11/11/94  Fri.    15:42:01
bn.exe             2644489  01/25/95  Wed.    08:22:19
install.bat         147222  01/31/95  Tues.   08:52:34
ti.cfg                 184  01/31/95  Tues.   14:59:33
debug.al             12568  01/31/95  Tues.   15:00:17
freboot.exe         173040  01/31/95  Tues.   15:00:21
frediag.exe         230405  01/31/95  Tues.   15:00:49
 
  $
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4. Verify that the directory holds the correct software image for your router 
or BNX platform (Table 6-2).

If your installation files or software image are not available, contact the Bay 
Networks Technical Response Center.

Booting with the ti.cfg File

You initialize the router or BNX platform once with the ti.cfg file. The ti.cfg file is 
a special file that boots the router or BNX platform without configuration. You 
then run the installation script to create an initial configuration. Never change the 
ti.cfg file or overwrite it with another configuration file. 

(Booting a new router or BNX platform uses the ti.cfg file by default. Performing 
this step verifies that you are using the correct configuration file.)

A normal, successful installation requires booting with the ti.cfg file only once, 
but under the following conditions you must reboot again with ti.cfg before 
running the Quick-Start installation script:

• The router or BNX platform is currently booted from a configuration file other 
than ti.cfg.

• You terminate the installation script.

Table 6-2. Router or BNX Platform Software Images  

Router
Router Software 
Image Runs On

AFN afn.exe Memory card

ASN asn.exe Memory card

BLN bn.exe Memory card

BCN bn.exe Memory card

BNX bnx.exe Memory Card

AN an.exe Memory card and
Flash Single Inline 
Memory Modules 
(SIMMs)

CN, FN, LN (VME) ace.out Memory card
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• You change the initial IP connector (port) that you use to communicate with 
the Site Manager workstation.

To boot the router or BNX platform using the ti.cfg file:

1. Enter the following command:

boot   <slot_number>:<image_file> <slot_number>:ti.cfg

<slot_number> identifies where the volume resides on the router or BNX 
platform and <image_file> is the software image for your router or BNX 
platform (refer to Table 6-2).

Example:

boot 2:bn.exe 2:ti.cfg

The router or BNX platform boots and runs through its startup procedure.

2. Establish a new Technician Interface session.

See Chapter 5 for instructions.

Running the Quick-Start Installation Script

After booting the router or BNX platform with the ti.cfg file and establishing a 
new Technician Interface session, you are ready to run the Quick-Start installation 
script (install.bat). 

Note: Use install.bat once to configure the initial interface only. To configure 
other interfaces, use Site Manager, Quick2Config, or other router management 
software to create new configurations, as described in Chapter 11.
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To run the script:

1. Review Table 6-3 for the commands you use to run the script.

2. Change to the slot where the router’s memory card resides by entering

cd <slot_number>:

Include the colon (:) after the slot number as part of the command string.

3. Start the script by entering

run install

The Quick-Start installation script begins. 

Table 6-3. Quick-Start Installation Script Commands

To Do the 
Following Action Result

Accept a default 
value

Press Return Your terminal displays default values in 
brackets; for example, [E21].

Repeat a step 
(for example, if you 
make a mistake)

Press Control-c When prompted Terminate script y/n?, 
type n. The Technician Interface returns to 
the beginning of the step so you can re-
enter the information.

Quit out of the 
Quick-Start 
installation script

Press Control-c When prompted Terminate script y/n?, 
type y. The Quick-Start script terminates 
and returns to the Technician Interface 
prompt. Reboot the router or BNX platform 
using the ti.cfg file before rerunning the 
Quick-Start installation script.
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Figure 6-3. Beginning of the Quick-Start Installation

4. Enter the network information as you are prompted. 

Refer to your Network Information Worksheet as you proceed through the 
script. See Appendix A for a sample script. The script prompts you to enter 
information for

— The physical connector

— IP interface configuration

— IP routing protocol

— TFTP and FTP default volumes

— Telnet (optional)

— Site Manager workstation address

Many steps in the installation script suggest default values you should accept. 
Some steps are optional for your network requirements. 

The script displays a summary of the newly configured IP interface 
(Figure 6-4), and then prompts you to save the configuration to a file.

       ####    #   #   #      #   # #### ##### #     #  ##  ###  #  #  ###
       #   #  # #   # #       ##  # #      #   #     # #  # #  # #  # #
       ####  #   #   #        # # # ###    #   #  #  # #  # ###  ##   ###
       #   # #####   #        #  ## #      #   # # # # #  # #  # # #     #
       ####  #   #   #        #   # ####   #    #   #   ##  #  # #  # ###

               ###  #  # ###  ## #  #      ### #####  #   ###  #####
              #   # #  #  #  #   # #      #      #   # #  #  #   #
              #   # #  #  #  #   ##   ### ###    #  #   # ###    #
              # # # #  #  #  #   # #         #   #  ##### #  #   #
               ###  #### ###  ## #  #     ###    #  #   # #  #   #
                  #

                                   Version 1.108
                               Copyright 1993-1996
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Figure 6-4. Summary Information for a Quick-Start Installation

5. Save the configuration file as startup.cfg.

Accept the default name of startup.cfg. You save this initial IP configuration 
to the file to maintain a permanent copy. If you do not save the configuration 
to a file, you will lose it the next time you reboot the router or BNX platform. 

The router or BNX platform then tests the IP interface configuration by 
“pinging” its own interface. If successful, it prompts you for the IP address of 
the Site Manager workstation.

6. Enter the IP address of the Site Manager workstation.

The router or BNX platform pings the Site Manager workstation. If the ping is 
successful, the initial IP interface is enabled and the script displays this 
message:

Quick-Start Installation Completed

Note: If you terminate the installation script, reboot the router or BNX 
platform using the ti.cfg file before you rerun the Quick-Start installation 
script.

                              Configuration Summary
                              ---------------------

Link Module:         QE/NF
Connector:           1
Slot:                2
Circuit Name:        E21
IP address:          192.168.125.34
IP subnetwork mask:  255.255.255.0
Routing Protocol:    RIP
Default Rt. Listen:  YES
TFTP Default Volume: 2:
FTP Default Volume:  2:
TI TELNET:           No

Press [RETURN] to continue: 
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The Technician Interface prompt appears and you have completed the Quick-
Start procedure. Don’t reboot the router or BNX platform after successfully 
completing this procedure.

Quick-Start Troubleshooting

If the router or BNX platform cannot ping the Site Manager workstation 
during the Quick-Start installation:

— Check the physical connections.

— If the Site Manager workstation is a PC, Distinct or other networking 
software must be running for a successful ping. (See Chapter 7 for 
Distinct installation instructions.) You can skip the ping test by typing Q 
and later verify that the PC is communicating with the router.

— Verify the IP address of the router or BNX platform. Use the show ip 
circuits command in the Technician Interface to make sure that the 
physical interface is up and that the IP address is correct. For more 
information about the show command, refer to Using Technician 
Interface Scripts. 

— Verify the IP address and subnetwork mask address of the Site Manager 
PC or workstation.

— Verify that routing is working, if the workstation is on a different network. 
Use the show ip routes command in the Technician Interface to examine 
the routing table and verify that there is a route or a default route to the 
network where the Site Manager workstation is located. For more 
information about the show command, refer to Using Technician 
Interface Scripts. 

Note: Boot with the ti.cfg file and run install.bat once to configure the initial 
interface only. To configure other interfaces, use Site Manager, Quick2Config, 
or other router management software to create new configurations, as 
described in Chapter 11.
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Assigning a Password 

If you want to assign a security password to the Technician Interface before 
logging out of the Technician Interface, see Using Technician Interface Software 
for instructions. 

Exiting the Technician Interface

To exit the Technician Interface interface, type logout at the prompt.

If you used an ASCII console to establish a Technician Interface session, you can 
now disconnect it from the router or BNX platform. If you used terminal 
emulation to establish a Technician Interface session, select File➔Exit. 

After you install Site Manager, you use the Technician Interface primarily as a 
backup interface if Site Manager becomes unavailable.
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Chapter 7
Installing Site Manager on a PC

Use Site Manager to remotely configure and manage the router or BNX platform 
over the IP network. You install Site Manager on a PC in this order:

• Review system requirements

• Install Distinct TCP/IP or equivalent WINSOCK-compatible TCP/IP stack 

• Load the Site Manager software

• Start up Site Manager 

Reviewing System Requirements

Site Manager or Site Manager BNX for the PC requires the following to run:

• A 386 PC with at least 8 MB of RAM and at least 32 MB of free disk space. 
(We recommend a 486 PC with at least 8 MB of RAM.) 

• A CD-ROM drive — if you intend to load the Site Manager software from CD 
rather than disks.

• A VGA monitor. (We recommend a SuperVGA monitor.)

• DOS 5.0 or later.

• Microsoft Windows 3.1 or later.

• A network interface card (NIC) with a driver type of Packet, Network Driver 
Interface Specification (NDIS), or Novell Open Data Link Interface (ODI). 

• The supplied Distinct TCP/IP for Microsoft Windows, Version 3.31 or any 
WINSOCK-compatible TCP/IP stack, including NetManage Chameleon, 
Novell’s LAN Workplace, and FTP Software’s PC/TCP for Windows. 
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Installing Distinct TCP/IP

Site Manager on the PC uses a WINSOCK-compatible TCP/IP stack to 
communicate across the IP network. If you already have an installed TCP/IP 
stack, you can use it with Site Manager. If not, Bay Networks supplies Distinct 
TCP/IP for Microsoft Windows, a Distinct Corporation application, with Site 
Manager. Appendix B provides an example of a successful Distinct installation.

You install TCP/IP or its equivalent by

• Preparing information for 

— Serial number and key code

— Network interface card and driver

— Network configuration

• Loading the Distinct software

• Testing Distinct

This section provides the general guidelines for installing Distinct TCP/IP. For 
detailed instructions about the Distinct product, refer to Distinct TCP/IP for 
Microsoft Windows Run Time Installation and Configuration Guide, the Distinct 
Corporation documentation supplied with Site Manager. Also check the Bay 
Networks Read Me First documentation for changes to the installation 
instructions.

The use of Distinct’s TCP/IP Run Time software is subject to the Distinct 
Software License Agreement. Each Distinct License Agreement allows you to 
install Distinct on up to 15 PCs per IP subnet. We recommend installing and 
configuring Distinct’s TCP/IP Run Time software successfully on one PC before 
you install it on additional systems.

Only the Distinct features required for Site Manager — TFTP and Ping — are 
operational. To obtain a complete version of Distinct, contact the Distinct 
Corporation at 408-366-8933.

If you use another WINSOCK-compatible TCP/IP stack, consult its 
documentation for installation requirements. After installation, proceed to the 
section “Starting Up Site Manager” later in this chapter.
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Preparing Information for the Distinct Installation

The Distinct installation prompts you to provide

• Serial number and key-code information

• Network interface card and driver information

• Network configuration information

Preparing Serial Number and Key-Code Information

You must initialize the software at installation time by entering a serial number 
and a key code. There is a serial number associated with each copy of the software 
licensed. You must use a different serial number for each computer on which you 
install the software.

Table 7-1. Distinct Serial Numbers and Key Codes

Serial No. Key Code

R00WELLF00 F6-73-F2

R00WELLF01 00-53-46

R00WELLF02 EA-B3-00

R00WELLF03 F4-93-BC

R00WELLF04 9E-F3-D5

R00WELLF05 88-D3-1E

R00WELLF06 92-33-F1

R00WELLF07 BC-13-60

R00WELLF08 A6-73-20

R00WELLF09 B0-53-E6

R00WELLF10 FF-53-5C

R00WELLF11 09-33-43

R00WELLF12 F3-93-73

R00WELLF13 FD-73-37

R00WELLF14 A7-D3-17
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Preparing Network Interface Card and Driver Information

The Distinct installation process prompts you for the network interface card 
installed on your PC, the card driver, and the driver type you want to use. Driver 
types are

• NDIS

• ODI

• Packet

Normally, driver types NDIS and ODI involve less configuration than the Packet 
type. 

Distinct and other applications include standard card drivers with their software. 
An incorrect or outdated driver generates an error message such as Bind Failed 
upon reboot. If this happens, verify from the network interface card 
documentation that you selected the right card model, driver, and driver type. Try 
using the driver supplied on disk with the card or contact the card manufacturer 
(via FTP) for the latest update to the driver.

If Distinct doesn’t support your driver, refer to the section “Configuring the 
System for Your Own Ethernet or Token Ring Driver” in Chapter 2 of the Distinct 
TCP/IP for Microsoft Windows manual. 

If you have a laptop PC and are using a Xircom Pocket Ethernet Adapter to fulfill 
the NIC system requirement, we recommend selecting the “NDIS Driver over 
Ethernet” procedure in Chapter 2 of the Distinct manual.

Depending on your network interface card, you may also be prompted to change 
information about

• Hardware interrupt

• I/O base address

• Memory address

• Transceiver

Accept the defaults for this information unless you have a reason for making a 
change.
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Preparing Network Configuration Information

Use the worksheet in Table 7-2 to prepare the information Distinct TCP/IP needs 
to know about the configuration of your network. A minimum network 
configuration includes

• The gateway to this subnet

• Your host PC

• Any other hosts on this subnet

The installation process prompts you for this configuration information.

Table 7-2. Distinct Configuration Worksheet

Information Default Your Information

LAN

 System Name

 Internet Address

 Subnet Address

 Default Gateway

Domain

 Domain Name

 Primary Server

 Alternate Server

Serial

 Client Name <none>

 Server Name <none>

 Type: SLIP or PPP <not enabled>

 Compression <disabled>

 State <disabled>

 Scripts <none>

 Com Port (if SLIP or PPP) 1

 Parameters (if SLIP or PPP) 9600,N,8,1
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Installing the Distinct Software

You can install Distinct software from the Site Manager CD or from a disk. 

From CDs

To load Distinct from the Site Manager CD:

1. Insert the Bay Networks Site Manager CD into your CD-ROM drive.

2. Double-click on the File Manager icon.

3. Click on the CD-ROM drive icon in the File Manager window.

4. Click on the Distinct icon in the top-level directory.

5. Double-click on the setup.exe utility to start the program.

The Distinct installation process prompts you for path and directory 
information. Accept the default suggestions unless you have reason to change.

The process then prompts you for the information you prepared in the 
previous sections about

• Serial number and key code

• Network interface card and driver

• Network configuration

For specific questions about the Distinct configuration process, refer to the 
Distinct TCP/IP for Microsoft Windows Run Time Installation and 
Configuration Guide. Also refer to the sample installation in Appendix B.

6. At the end of the Distinct installation, accept the prompt to reboot the 
PC.

You reboot the PC to load the TCP/IP stack and set up the environment 
variables.

7. Enter Windows. The Distinct Group window is open on the desktop.

8. Proceed to the section “Testing Distinct TCP/IP” and test the Distinct 
TCP/IP configuration before installing Site Manager.
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From disks

To load Distinct from a disk:

1. Insert the Distinct TCP/IP disk into the disk drive.

2. Select File➔Run.

3. Enter the following in the Command Line box to install the Distinct TCP/
IP Run Time software:

<drive>:\setup

<drive> specifies the drive (for example, A or B) in which you inserted the 
Distinct TCP/IP Run Time disk.

The Distinct installation process prompts you for path and directory 
information for installing the software. Accept the default suggestions unless 
you have reason to change.

The process then prompts you for the information you prepared in the 
previous sections about

• Serial number and key code

• Network interface card and driver

• Network configuration

For specific questions about the Distinct configuration process, refer to the 
Distinct TCP/IP for Microsoft Windows Run Time Installation and 
Configuration Guide. Also refer to the sample installation in Appendix B.

4. At the end of the Distinct installation accept the prompt to reboot the PC.

You reboot the PC to load the TCP/IP stack and set up the environment 
variables.

5. Enter Windows. The Distinct Group window is open on the desktop.

6. Proceed to the section “Testing Distinct TCP/IP”and test the Distinct 
TCP/IP configuration before installing Site Manager.
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Testing Distinct TCP/IP 

Use the Distinct ping function to send an echo request to the router or BNX 
platform after installing and configuring Distinct TCP/IP. This procedure tests the 
functionality of your network and your Distinct configuration. 

Perform the test as follows:

1. From the Program Manager window, double-click on the Distinct icon.

2. Double-click on the Ping icon.

The Distinct TCP/IP Ping window appears.

3. Select Host in the menu bar.

4. Enter the name or address of the host in the Host box.

5. Click on Select.

6. Select the Start option in the menu bar.

The display indicates the number of requests transmitted and replies received. 
If both are increasing, your network and your Distinct configuration are 
functional.

7. Select the Stop option in the menu bar to terminate the test.

The Distinct TCP/IP Ping window appears.

8. Select Exit in the menu bar.

Distinct TCP/IP must be successfully loaded before installing Site Manager. If the 
installation is unsuccessful, review Appendix C, “Trouble Shooting,” in Distinct 
TCP/IP for Microsoft Windows Run Time Installation and Configuration Guide.
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Loading the Site Manager Software

After you install Distinct or other Windows Sockets-supported TCP/IP stack, 
you’re ready to load the Site Manager software.

Site Manager software is distributed on CDs and disks. The following section 
describes the installation procedures for both types of media. It assumes that 
Windows is running.

From CDs:

1. Insert the Bay Networks Site Manager CD into your CD-ROM drive.

2. Double-click on the File Manager icon.

3. Click on the CD-ROM drive icon in the File Manager window.

4. Click on the ms_win directory.

5. Double-click on the setup.exe utility.

The installation process prompts you for the directory in which you want to 
install Site Manager. 

6. Enter the directory in which to install Site Manager, or accept the 
default, c:\WF.

The Site Manager files install in the chosen directory. When the installation 
completes, the following prompt appears:

Create windows program group/items automatically?

7. To allow Site Manager to automatically create a Windows group, click on 
Yes.

If you want to manually create a Windows group, click on No. You can 
manually create a Windows group later as specified in the section “Creating a 
Windows Group.” Then proceed to the section “Starting Up Site Manager.”

Note:  If your PC uses the IBM Token Ring Adapter driver, you must install 
the IBM LAN Support driver package before installing Site Manager.

Caution: If you are reinstalling Site Manager, be aware that the installation 
will overwrite the c:\windows\siteman.ini file. If you are installing multiple 
versions of Site Manager on the same PC, make a copy of this file and later 
edit the new file with the information about the other versions.
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8. Click on “Yes” at the prompt to start Site Manager.

The following prompt appears:

Do you want to start Site Manager now?

Select Yes to start Site Manager. Select No to return to Windows.

From disks:

1. Insert the PC Site Manager disk 1 into the disk drive.

2. Select File➔Run.

3. Type the following in the Command Line box to install the Site Manager 
software:

<drive>:\setup

<drive> specifies the drive (for example, A or B) in which you inserted the 
PC Site Manager disk 1.

Install the remaining disks as you are prompted.

The Site Manager files install in the chosen directory. When the installation is 
complete, the following prompt appears:

Create windows program group/items automatically?

4. To allow Site Manager to automatically create a Windows group, click on 
Yes.

If you want to manually create a Windows group, click on No. You can 
manually create a Windows group later as specified in the section “Creating a 
Windows Group.” Then proceed to the section “Starting Up Site Manager.”

5. Click on “Yes” at the prompt to start Site Manager.

The following prompt appears:

Do you want to start Site Manager now?

Select Yes to start Site Manager. Select No to return to Windows.

Note: The set of disks shipped with Site Manager includes disks with scripts 
for the Technician Interface feature. You don’t have to install them until you 
need them. Refer to Using Technician Interface Scripts for more information.
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Creating a Windows Group

The following example shows you how to create a sample Windows group for the 
Site Manager executable software. (You only need to do this if you chose to 
manually create a Windows program group.)

1. Create a Program Object:

a. Select File➔New.

The New Program Object window appears.

b. Select the Program Group option and click on OK.

The Program Group Properties window appears.

c. Enter Site Manager in the Description box.

d. Enter WF in the Group File box.

e. Click on OK.

2. Create a Program Item:

a. Select File➔New. 

The Program Item window appears with Program Item selected.

b. Click on OK.

c. Enter PC/Site Manager in the Description box.

d. Enter c:\WF\wfsm.exe in the Command box.

e. Enter c:\WF\config in the Working Directory box.

f. Click on OK.

Adding a Well-Known Service for TFTP

If you want to add a well-known service like TFTP, you have to edit the services 
file provided with the Distinct or equivalent TCP/IP stack. The services file 
provides the post number and type of service.
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Add a well-known service to the services file for TFTP as follows:

1. Change to the directory where the services file resides. 

Some protocol stacks store the services file in the same directory as the 
protocol software. For Distinct, the services file resides in the etc directory. 

2. At the DOS prompt, type

cd c:\etc

3. Enter the following command to edit the services file:

edit services

The services file appears.

4. Verify that the following lines are present or insert them:

tftp 69/udp
snmp 161/udp
snmp-trap 162/udp

5. Press Alt-f to display the File menu, type x to exit, and type y to save the 
changes. 

Starting Up Site Manager

Start up the Site Manager application from Windows as follows:

1. Select the Site Manager program group.

2. Double-click on the PC/Site Manager icon.

The Site Manager window appears (Figure 7-1). 

After you have successfully installed and started up Site Manager, proceed to 
Chapter 11 to create a pilot configuration file.

Note: All TCP/IP stacks use a services stack. For example, Chameleon uses 
\net\netmanag\services. The location of the services stack may vary with your 
IP package.
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Figure 7-1. Site Manager Window
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Chapter 8
Installing Site Manager on a SPARCstation

You use Site Manager to remotely configure and manage the router or BNX 
platform over the IP network. You install Site Manager on a SPARCstation in the 
following order:

• Review system requirements

• Set up the SPARCstation

• Load the Site Manager software

• Add Site Manager user accounts

• Verify Site Manager installation

• Start up Site Manager 

Reviewing System Requirements

The SPARCstation Site Manager or Site Manager BNX requires the following to 
run:

• Sun Microsystems Sun4 SPARCstation equipped with an Ethernet, Token 
Ring, or FDDI network adapter

• CD-ROM drive

• Sun OpenWindows 3.0 or later, or MIT X11 Window System 4.0 or later

• SunOS 4.1 or later, or Solaris 2.3 or later

• At least 16 MB of RAM; at least 55 MB of free disk space; and at least 32 MB 
of swap space
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Setting Up the SPARCstation

Before you load the Site Manager software on your SPARCstation:

1. Log in to the SPARCstation as root (or su root).

2. Edit the /etc/services system file (on each host device) to include the 
following lines at the bottom of the file:

snmp161/udp
snmp-trap162/udp

You can use any text editor to edit the file. The first line associates the service 
name snmp with UDP Port number 161 on this host device. The second line 
associates the service name snmp-trap with UDP Port number 162. 

3. Save /etc/services, and exit from the text editor.

Loading the Site Manager Software

Load the Site Manager software on the SPARCstation as follows:

1. Insert the Site Manager CD into your CD-ROM drive.

2. If you have not already created a CD-ROM mountpoint, log in as root 
and create a root-level directory. For example, enter

mkdir /cdrom

3. Mount the CD-ROM drive as follows:

Note: On SunOS, enter
mount -r -t hsfs   /dev/<device_number>  /cdrom

<device-number> is the device number assigned to the CD-ROM drive 
(example – sr0).

Example

mount -r -t hsfs   /dev/sr0  /cdrom

On Solaris, enter

mount -F hsfs -o ro /dev/dsk/<device_number>  /cdrom

<device_number> is the device number assigned to the CD-ROM drive 
(example – c0t6d0s0).
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Example

mount -F hsfs -o ro /dev/dsk/c0t6d0s0  /cdrom

4. Change to the CD-ROM mountpoint by entering

cd /cdrom

or, if you use Solaris and are running the vold daemon, by entering

cd /cdrom/release_1000_400

for a router or, for a BNX platform, entering

cd /cdrom/release_600

5. Run the script to load the Site Manager software by entering

. / INSTALL.SH

Type the command in all uppercase letters. The installation process 

— Lists the directories that contain enough space to install Site Manager. 
You can then specify which directory you want to use.

— Executes the Site Manager installation script, WFSM_INSTALL. 

When the installation is finished, your workstation displays the message 

Site Manager Installation Complete.

Additional messages about your SPARCstation environment may appear.

6. Press Control-d to exit the root account.

Adding Site Manager User Accounts

Set up individual Site Manager users on the SPARCstation as follows:

1. Log in to the user’s account.

Note: If you use Solaris and you are running the vold daemon, the CD-ROM 
will automatically mount as /cdrom/release_1000_400 rather than /cdrom.

Note: For BNX, skip Step 2 because BNX does not support Image Builder.
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2. If this is the first time you’ve installed Site Manager, create the directory 
in which to install the Site Manager’s image builder application by 
entering

mkdir   $HOME/.builder_dir

3. Edit the user’s account setup file on C and Bourne shells as follows:

• If you use csh or clones, add the following lines to .cshrc:

set path = ($path   /usr/wf/bin)
setenv   WF_SMPATH /usr/wf
setenv   SMTERM X
setenv   SM_CONFIGS <directory where config files are stored >
setenv   BUILDER_DIR    $HOME/.builder_dir

• If you use the Bourne shell (sh) or clones, then add the following lines to 
.profile:

PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/builder_dir
export   WF_SMPATH    SMTERM     SM_CONFIGS BUILDER_DIR

Note: For BNX, do not include the last line about BUIDER_DIR.

Note: If the shell variable path is already set in some other line of the .cshrc 
file, then add these new lines immediately after the last set path line.

Note: For BNX, do not include the BUILDER_DIR line and the references to 
BUILDER_DIR in the last line. 
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4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site Manager.

Verifying Site Manager Installation

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. Open your windows environment (X Windows or OpenWindows).

3. Verify the Site Manager installation by entering

wfchkinst

After installation is verified, the workstation displays the message

 Installation is complete and correct!

4. Verify the Site Manager environment by entering

wfchkenv

After the environment is verified, the workstation displays the message

Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager installed.

Starting Up Site Manager

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager operation.

2. Open your windows environment (X Windows or OpenWindows).

3. Change to the directory where you want to store configuration files. 

The following sample command changes to the directory
 /home/siteman/config_files:

cd   /home/siteman/config_files

Note: If your environment variables are incorrect, you’ll receive an error 
message to reset the variables.
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4. Activate Site Manager by entering the following command: 

wfsm    -a   <router_IP_address > & 

<router_IP_address>  is the IP address of the router or BNX platform’s 
initial IP network interface you configured in Chapter 6.

Example

wfsm    -a    192.168.125.34 &

The Site Manager window appears (Figure 8-1).

Figure 8-1. Site Manager Window
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After you have successfully installed and started up Site Manager, proceed to 
Chapter 11 to create a pilot configuration file.

Starting Site Manager from SunNet Manager

To start a Site Manager session on a platform running SunNet Manager:

1. Open a view containing the icon of a router or BNX platform that you 
want to configure using Site Manager.

2. Click on the icon of the router or BNX platform you want to configure.

3. From the Tools menu, choose Tools, then drag right and choose Site 
Manager (Figure 8-2).

The Site Manager window appears.

Figure 8-2. Starting a Site Manager Session from SunNet Manager
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Starting Site Manager from OpenView

Read this section if you plan on installing or are currently running the HP 
OpenView application on your SPARCstation.

If you install OpenView after you install the Site Manager software, follow these 
steps to integrate Site Manager with the OpenView application:

1. Change to the /usr/wf directory.

2. Re-execute the Site Manager script by entering

. / WFSM_INSTALL

In the future, follow these steps any time you reinstall OpenView.

To start a Site Manager session from the IP Internet window menu bar in 
OpenView, follow these steps:

1. Open a view containing the icon of the router or BNX platform that you 
want to configure using Site Manager.

2. Click on the icon of the router or BNX platform you want to configure.

The IP Internet window opens (Figure 8-3).

3. Choose Site Manager from the Tools menu, as shown in Figure 8-3.

A list of options available from Site Manager appears.
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Figure 8-3. Starting a Site Manager Session from OpenView
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Chapter 9
Installing Site Manager on an RS/6000

You use Site Manager to remotely configure and manage the router or BNX 
platform on an IP network. You install Site Manager on an RS/6000 workstation 
in the following order:

• Review system requirements

• Load Motif

• Load the Site Manager software

• Add Site Manager user accounts

• Verify Site Manager installation

• Start up Site Manager 

Reviewing System Requirements

The RS/6000 Site Manager or Site Manager BNX requires the following to run:

• IBM RISC System/6000 equipped with either an IBM Ethernet 
High-Performance network adapter or an IBM Token Ring 
High-Performance network adapter

• IBM AIX Version 3.2.4 or later

• X11 Release 5 or later

Note: When ordering an IBM RS/6000 or an upgrade of the IBM AIX, request 
X11 Release 5. Site Manager does not run with earlier versions of X11.
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• Motif 1.1.4 or later (see the following section, “Loading Motif.”)

•  CD-ROM drive

• 16 MB of RAM (minimum)

• 50 MB of free disk space (minimum)

• 64 MB of swap space (minimum – use 96 MB of swap space with the 
NetView/6000 application)

Loading Motif

NetView/6000 Versions 2.1 and earlier require Motif Version 1.1.4. However, X11 
Release 5 typically ships with Motif Version 1.2 as the default. Therefore, if you 
are using NetView/6000 Version 2.1, and you are running a later version of Motif 
(such as 1.2), then you must use the instructions that follow to switch the currently 
installed version of Motif to Motif Version 1.1.4. This allows Site Manager and 
NetView/6000 Version 2.1 to operate. 

Switch to Motif 1.1.4 as follows:

1. Enter the following AIX commands:

 /usr/lpp/X11rte/set_symlinks.Motif1.1
 /usr/lpp/X11dev/set_symlinks.Motif1.1

2. Restart NetView/6000.

To switch back to Motif 1.2:

a. Enter the following AIX commands:

/usr/lpp/X11rte/set_symlinks.Motif1.2
/usr/lpp/X11dev/set_symlinks.Motif1.2

b. Restart NetView/6000.

Note: The services (network services) directory supplied with the operating 
system should be complete. If the snmp or snmp-trap files are missing, contact 
your system administrator.
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Loading the Site Manager Software

Load the Site Manager software on the RS/6000 as follows:

1. Insert the Bay Networks Site Manager CD into your CD-ROM drive.

2. If you have not already created a CD-ROM mountpoint, log in as root 
and create a root-level directory. For example, enter

mkdir /cdrom

3. To mount the CD-ROM drive, enter

mount -o ro -v cdrfs /dev/<device_number>   /cdrom

<device_number> is the number of the device assigned to the CD-ROM drive 
(Example – cd0). 

Example

mount -o ro -v cdrfs /dev/cd0  /cdrom

4. Change to the CD-ROM mountpoint by entering

cd /cdrom

5. Run the script to load the Site Manager software by typing

. /install.sh

Type the command in all lowercase letters. The installation process 

— Lists the directories that contain enough space to install Site Manager. 
You can accept the default or specify which directory you want to use.

— Executes the Site Manager installation script, WFSM_INSTALL.

When the installation is finished, your workstation displays the message 

Site Manager Installation Complete.

6. Press Control-d to exit the root account.
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Setting Up Site Manager User Accounts

Set up individual Site Manager users on the RS/6000 as follows:

1. Log in to the user’s account.

2. Create the directory for the Site Manager’s image builder application by 
entering

mkdir   $HOME/.builder_dir

3. Edit the user’s account setup file as follows for C and Bourne shells:

• If you use csh or clones, then add the following lines to .cshrc:

set path = ($path   /usr/wf/bin)
setenv   WF_SMPATH /usr/wf
setenv   SMTERM X
setenv   SM_CONFIGS <directory where config files are stored >
setenv   BUILDER_DIR    $HOME/.builder_dir

• If you use the Bourne shell (sh) or clones, then add the following lines to 
.profile:

PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/builder_dir
export PATH WF_SMPATH SMTERM SM_CONFIGS BUILDER_DIR

Note: For BNX, skip Step 2 because BNX does not support Image Builder.

Note: For BNX, do not include the last line about BUIDER_DIR.

Note: If the shell variable path is already set in some other line of the .cshrc 
file, then add these new lines immediately after the last set path line.

Note: For BNX, do not include the BUILDER_DIR line and the references to 
BUILDER_DIR in the last line.
9-4



Installing Site Manager on an RS/6000
4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site Manager.

Verifying Site Manager Installation

 Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. Start up the X Windows environment.

3. Verify the Site Manager installation by entering

wfchkinst

After installation is verified, the workstation displays the message

 Installation is complete and correct!

4. Verify the Site Manager environment by entering

wfchkenv

After the environment is verified, the workstation displays the message 

Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager installed.

Starting Up Site Manager

Start up the Site Manager application on an RS/6000 as follows:

1. Log in to a user account that has been set up for Site Manager operation.

2. Start up the X Window environment.

3. Change to a directory where you want to store configuration files. 

Example

The following sample command changes to the directory
/home/siteman/config_files:

cd /home/siteman/config_files
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4. Activate Site Manager by entering the following command: 

wfsm -a <router_IP_address> & 

<router_IP_address> is the IP address of the router or BNX platform’s initial 
IP network interface. A sample command is as follows:

wfsm -a 192.168.125.34 &

The Site Manager window appears (Figure 9-1). 

After you have successfully installed and started up Site Manager, proceed to 
Chapter 11 to create a pilot configuration.

Figure 9-1. Site Manager Window
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Starting Site Manager from NetView/6000

Read this section if you plan on installing or are currently running the
NetView/6000 application on your RS/6000 workstation.

If you install NetView/6000 on your RS/6000 after you install the Site Manager 
software, follow these steps to integrate Site Manager with the NetView/6000 
application:

1. Change to the /usr/wf directory.

2. Re-execute the Site Manager script by entering

. / WFSM_INSTALL

In the future, follow these steps any time you reinstall NetView/6000.

To start a Site Manager session from the IP Internet window menu bar in 
NetView:

1. Open a view containing the icon of the router or BNX platform that you 
want to configure using Site Manager.

2. The IP Internet window appears with a map of your Internet.

3. Click on the icon of the router or BNX platform you want to configure.

4. Choose Site Manager from the Tools menu shown in Figure 9-2.

A list of options available from Site Manager appears.
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Figure 9-2. Starting a Site Manager Session from NetView

I P  I n t e r n e t

E d i t V i e w O p t i o n sL o c a t e HelpF i l e M o n i t o r T e s t A d m i n i s t e rT o o l s

M I B  A p p l i c a t i o n  B u i l d e r :  S N M P . . .

M I B  B r o w s e r :  S N M P . . .

G r a p h  C o l l e c t e d  D a t a :  S N M P

D a t a  C o l l e c t i o n  &  T h r e s h o l d s :  S N M P . . .

F i l t e r  E d i t o r . . .

S i t e  M a n a g e r

S y n O p t i c s  A p p l i c a t i o n

F a i l i n g  R e s o u r c e  D i s p l a y . . .

M a i l . . .

P r i n t . . .

S i t e  M a n a g e r . . .

C o n f i g u r a t i o n  ( d y n a m i c ) . . .

S t a t i s t i c s  M a n a g e r . . .

T r a p  M o n i t o r . . .

R e m o t e  F i l e s  M a n a g e r . . .

E v e n t  F i l e s . . .

U p d a t e  S y m b o l s . . .

U 2844 2
9-8



Chapter 10
Installing Site Manager on an HP 9000

Use Site Manager to remotely configure and manage the router on the IP network. 
You install Site Manager on an HP 9000 workstation in this order:

• Review system requirements

• Load the Site Manager software

• Add Site Manager User Accounts

• Verify Site Manager Installation

• Start up Site Manager 

Reviewing System Requirements

The HP 9000 Site Manager requires the following to run:

• HP Precision Architecture System (HP 9000/7xx or HP 9000/8xx) equipped 
with an Ethernet network adapter or a Token Ring network adapter

• HP-UX 9.01 or later releases

• X11 Release 5 or later

• Motif Version 1.2 or later

• 16 MB of RAM (minimum)

• 65 MB of free disk space (minimum)

Note: BNX Site Manager does not run on the HP 9000 workstation.
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• 32 MB of swap space (minimum)

• CD-ROM drive

Loading the Site Manager Software

Load the Site Manager software on the HP 9000 as follows:

1. Insert the Site Manager CD into your CD_ROM drive.

2. If you have not already created a CD-ROM mountpoint, log in as root 
and create a root-level directory. For example, enter

mkdir /cdrom

3. Mount the CD-ROM drive by entering

mount -r -o ro -t cdfs /dev/dsk/<device_number>  /cdrom

<device_number> is the number of the device assigned to the CD-ROM drive 
(Example – c201d2s0).

Example

mount -r -o ro -t cdfs /dev/dsk/c201d2s0  /cdrom

4. Change to the CD-ROM mountpoint by entering

cd /cdrom

5. Run the script to load the Site Manager software by typing

. / “INSTALL.SH;1”

Type the command in all uppercase letters.

The installation process

— Lists the directories that contain enough space to install Site Manager. 
Accept the default or specify which directory you want to use.

— Executes the Site Manager installation script, WFSM_INSTALL. 

When the installation is finished, your workstation displays the message: 

Site Manager Installation Complete.

Note: The services (network services) directory supplied with the operating 
system should be complete. If the snmp or snmp-trap files are missing, contact 
your system administrator.
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6. Press Control-d to exit the root account.

Adding Site Manager User Accounts

Set up individual Site Manager users on the HP 9000 as follows:

1. Log in to the user’s account.

2. Create the directory for the Site Manager’s image builder application by 
entering

mkdir   $HOME/.builder_dir

3. Edit the user’s account setup file using a C or Bourne shell as follows:

• If you use csh or clones, then add the following lines to .cshrc:

set path = ($path   /usr/wf/bin)
setenv   WF_SMPATH /usr/wf
setenv   SMTERM X
setenv   SM_CONFIGS <directory where config files are stored >
setenv   BUILDER_DIR    $HOME/.builder_dir

• If you use the Bourne shell (sh) or clones, then add the following lines to 
.profile:

PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/.builder_dir
export   WF_SMPATH    SMTERM     SM_CONFIGS  BUILDER_DIR

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run the Site Manager 
application.

Note: If you get the message OvwDbInit failed, OpenView is not installed. 
See the section “Starting Site Manager from OpenView” for information.

Note: If the shell variable path is already set in some other line of the .cshrc 
file, then add these new lines immediately after the last set path line.
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Verifying Site Manager Installation

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. If it is not already started, start up the HP VUE or X Window 
environment.

3. Verify the Site Manager installation by entering

wfchkinst

After installation is verified, the workstation displays the message

Installation is complete and correct!

4. Verify the Site Manager environment by entering

wfchkenv

After the environment is verified, the workstation displays the message 

Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager installed.

Starting Up Site Manager

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager operation.

2. If it is not already started, start up the HP VUE or X Window 
environment.

3. Change to a directory in which you want to store configuration files. 

Example

The following command changes to the directory /home/siteman/config_files:

cd   /home/siteman/config_files

4. Activate Site Manager by entering the following command:

wfsm -a <router_IP_address > & 

<router_IP_address> is the IP address of the router’s initial IP network 
interface, which you configured in Chapter 6.
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Example

wfsm -a 192.168.125.34 &

The Site Manager window appears (Figure 10-1).

After you have successfully installed and started up Site Manager, proceed to 
Chapter 11 to create a pilot configuration.

Figure 10-1. Site Manager Window
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Starting Site Manager from OpenView

Read this section if you run the HP OpenView application on your HP 9000 
workstation.

If you install OpenView after you install the Site Manager software, follow these 
steps to integrate Site Manager with the OpenView application:

1. Change to the /usr/wf directory.

2. Re-execute the Site Manager script by entering

. / WFSM_INSTALL

In the future, follow these steps any time you reinstall OpenView.

To start a Site Manager session from the IP Internet window menu bar in 
OpenView:

1. Open a view containing the icon of the router that you want to configure 
using Site Manager.

2. Click on the icon of the router you want to configure.

The IP Internet window opens (Figure 10-2).

3. Choose Site Manager from the Tools menu, as shown in Figure 10-2.

A list of options available from Site Manager appears.
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Figure 10-2. Starting a Site Manager Session from OpenView
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Chapter 11
Creating a Pilot Configuration File

In this chapter you use Site Manager to create a second IP interface on a router or 
BNX platform and save it as a new configuration file, pilot.cfg. In the process of 
creating this simple pilot configuration you learn to use several Site Manager 
configuration features. 

You use Site Manager to create a pilot configuration for the router or BNX 
platform in this order:

• Connect to the router or BNX platform 

• Use remote mode to create a configuration file

• Configure the pilot IP interface

— Add a circuit on a connector

— Enable the IP protocol

— Save the pilot configuration file

— Reboot the router or BNX platform with the pilot configuration file

— Enhance the pilot configuration file
11-1



Quick-Starting Routers and BNX Platforms
This chapter also introduces how to secure the router or BNX platform by

• Restricting read/write access 

• Setting the router or BNX platform to Secure mode

All examples in this chapter reflect the sample pilot configuration shown in 
Figure 11-1. Circuit E21 with IP Address 192.168.125.34 is the initial interface 
created with the Technician Interface. Circuit E22 with an IP address of 
192.1.182.1 is the pilot IP interface you’ll create with Site Manager. The router or 
BNX platform in Figure 11-1 contains a single memory card (volume), located in 
Slot 2.

Note: Accept the Site Manager default parameter settings as you create this 
pilot configuration file. Later, you can edit the parameters to meet your specific 
network needs using the instructions in Configuring Routers or Configuring 
Customer Access and Trunks (BNX Software) and in the protocol 
configuration manuals.
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Figure 11-1. Sample Pilot Configuration
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Connecting to the Router or BNX Platform

After you install Site Manager on your workstation, the initial Site Manager 
window appears (Figure 11-2). You select many of the major Site Manager menus 
and features from this screen.

The Site Manager window displays the IP address of the interface and system 
record information. To edit the system information, select the Platform ➔Edit 
System Information option (see Configuring Routers or Configuring Customer 
Access and Trunks (BNX Software) for details).

Figure 11-2. Site Manager Window
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When you are managing additional routers or BNX platforms from this 
workstation, you can connect to them from the initial Site Manager window by 
selecting Options➔Router Connections (see Configuring Routers or Configuring 
Customer Access and Trunks (BNX Software) for more information).

Using Remote Mode 

Site Manager offers three operating modes for configuring the router or BNX 
platform: remote, local, and dynamic. For the pilot configuration, use remote 
mode. 

1. Select Tools➔Configuration Manager➔Remote File.

The Edit Remote Configuration File window appears (Figure 11-3). Site 
Manager retrieves the file information from the router and displays it in this 
window. The Volume button on the right side of the screen identifies the 
volume on which the configuration file will be stored. 

Figure 11-3. Naming the Configuration File
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Usually, the volume is the number of the slot containing the memory card 
(except LNs and CNs that have two cards on a slot, or DOS drives). To access 
other memory cards residing in different slots:

a. Select the button showing the current volume and hold the mouse 
button down. 

A menu displays the NVFS volumes. 

b. Select the slot of the volume that you want and release the mouse 
button. 

The volume you selected appears.

In a DOS file system, the default volume is A. 

2. Select your initial configuration file, startup.cfg, and click on Open.

If you named the initial configuration file something other than startup.cfg, 
select that file instead.

In remote mode, Site Manager queries the router or BNX platform and displays its 
hardware configuration in the Configuration Manager window (Figure 11-4).

Figure 11-4. Configuration Manager Window
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The router or BNX platform model determines the number of slots in the window. 
Figure 11-4 shows 5 slots because the example is for a BLN. The window 
numbers each slot and identifies the module in each slot as well as the type and 
position of the connectors (or ports) on the module.

Configuring the Pilot IP Interface

Next, configure a pilot IP interface for the router or BNX platform as follows:

— Add a circuit on a connector

— Enable the IP protocol

— Save the pilot configuration file

— Reboot with the pilot configuration file

— Enhance the pilot configuration file

Adding a Circuit on a Connector

1. Select the Circuits➔Add Circuit option from the Configuration Manager 
window (refer to Figure 11-4).

The Add Circuit window appears (Figure 11-5). This window displays the 
connectors for each link module or net module installed in the router or BNX 
platform. The model determines the number of slots (or in the case of the 
ASN, the number of modules) shown in the window. Figure 11-5 shows 5 
slots for a BLN.

Note: The position of the slot numbers in the Configuration Manager window 
corresponds to that in the router or BNX platform. For the ASN, the module 
numbering in the Configuration Manager window represents that on the router 
or BNX platform. In the ASN, modules are the locations where the net modules 
reside.
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Figure 11-5. Add Circuit Window

2. Click on one of the available connectors.

After you click on a connector, Site Manager names the circuit that interfaces 
with this connector in the Circuit Name box. The default circuit name 
identifies the type of circuit and the location of the connector (Figure 11-6).
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Figure 11-6. Site Manager Default Circuit Name

Table 11-1 lists the default circuit types.

Note: We recommend that you follow the default circuit-naming conventions, 
so that circuit types and locations are represented consistently.

Table 11-1. Circuit-type Designators in Default Circuit Names  

Letter Designator Connector Type

A ATM

E Ethernet

E1 E1

F FDDI

H HSSI

MCE1 MCE1

MCT1 MCT1

O Token Ring

S Synchronous

T1 T1

Circuit Name: E22

Slot (or ASN module)
where connector resides

Type of circuit
(E = Ethernet)

Connector position on link module
or net module
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If you choose not to follow the conventions, enter a circuit name. Circuit 
names have a 15-character limit and must consist of alphabetical, numeric, 
underline, and slash characters. Do not enter spaces in circuit names. Circuit 
names are case-sensitive. 

3. Click on OK to save the circuit.

You must save each circuit after you associate it with a connector.

If the link module or net module has hardware filters, the following message 
appears: Do you want to enable Hardware Filters on this 
circuit? Click on OK to enable hardware filters. Otherwise, click on 
Cancel.

Enabling the IP Protocol

After you save the circuit, Site Manager displays the Select Protocols window 
(Figure 11-7). You enable the circuit with bridging and routing protocols from 
this window.

Note: The Select Protocols window differs slightly, depending on the circuit 
type. If appropriate, you may be prompted to select a WAN protocol. See 
Configuring Routers or Configuring Customer Access and Trunks (BNX 
Software) for more information.
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Figure 11-7. Select IP in the Protocols Window

1. Select the IP option and click on OK.

The IP Configuration window appears (Figure 11-8).

Figure 11-8. IP Configuration Window
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2. Enter the following information for the new IP interface:

— IP Address (Example – 191.1.182.1)

— Subnet Mask (Example – 255.255.255.0)

— Transmit Broadcast Address (Accepting the default of 0.0.0.0 calculates 
the actual address)

You can ignore the Unnumbered Associated Address parameter for now (see 
Configuring Routers or Configuring Customer Access and Trunks (BNX 
Software) for information).

3. Click on OK.

The Configuration Manager (Figure 11-4) appears again with the connector 
box highlighted to indicate that the circuit has been configured. Later, when 
you create a complete configuration file, you add circuits and select protocols 
for all circuits on the router or BNX platform.

Saving the Pilot Configuration File

From the Configuration Manager window, you save the configuration you just 
created to a file.

Note: Site Manager does not create a configuration file until you save the 
configuration information you specified.
11-12



Creating a Pilot Configuration File
1. Select the File➔Save As option.

The Save Configuration File window appears (Figure 11-9). This window displays 
the name startup.cfg —which is the file you retrieved earlier in the procedure.

Figure 11-9. Save Configuration File Window

2. Delete the text displayed in the Enter file name box.

3. Enter the name pilot.cfg, then click on Save.

Site Manager generates a configuration file, transfers it to the router or BNX 
platform (via TFTP), and saves it to the file system with the name pilot.cfg. 
Site Manager stores the file remotely on the router or BNX platform, because 
Site Manager is operating in Remote mode.

4. Click on OK when the File Saved pop-up window appears.

5. Select the File➔Exit option to exit the Configuration Manager window.

You are returned to the initial Site Manager window. 

Rebooting with the Pilot Configuration File

After you save the pilot configuration file, implement the configuration by 
rebooting the router or BNX platform. 

To reboot the router or BNX platform, from the Site Manager window (refer to 
Figure 11-2): 

1. Select Administration➔Boot Router.
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The Boot Router window appears (Figure 11-10). The default volume is 
displayed next to the boot image file (example: bn.exe) and configuration file 
(config). The default volume is the first available NVFS (indicated by slot 
number) or it is the DOS file system (indicated by the disk drive 
designator A). If your boot or configuration file is located on a different 
volume, you can click on the volume number to change it.

Figure 11-10. Sample Boot Router Window

2. Replace the text displayed in the Configuration box with the name of 
your configuration file, pilot.cfg.

3. Click on Boot. 

You’ll receive a confirmation asking if you want to proceed with the boot.

4. Click on OK.

Once you have successfully rebooted the router or BNX platform with the pilot 
configuration, the Quick-Start procedure is complete. The router or BNX platform 
is now operating on the network with two IP interfaces configured. 

Note: The software image and configuration file revert to their respective 
default volumes and filenames (example: bn.exe and config) after every boot 
unless you specify a different configuration file when you boot. To change the 
default configuration file to use your newly created file, use the Copy option to 
back up config, the old default file, to a new filename. Then use the Copy 
option again to overwrite the original config file with the new pilot.cfg file. 
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Enhancing the Pilot Configuration File

You are now ready to enhance the pilot configuration file. Use Configuring 
Routers or Configuring Customer Access and Trunks (BNX Software) and the 
protocol configuration manuals to learn how to

• Configure additional interfaces

• Modify the Site default parameter settings

• Implement optional features (for example, route filters) 

• Create new configuration files in the three operating modes: remote, local, and 
dynamic

Securing the Router or BNX Platform

You may want to take some steps to immediately secure the router or BNX 
platform by

— Restricting read/write access

— Setting secure mode

Restricting Read/Write Access

Site Manager uses SNMP to monitor and control the router or BNX platform. To 
safeguard against unauthorized SNMP access, we recommend that you restrict 
read/write access as soon as possible. You restrict read/write access by 
reconfiguring the SNMP community named “public.”

When you run the Quick-Start installation script (the install.bat file) and accept 
the default community, the script creates a read/write SNMP community named 
“public” with a wildcard manager (0.0.0.0). We strongly recommend that you 
restrict this read/write access as follows:

Note: Be sure to boot with the pilot.cfg file when enhancing your pilot 
configuration.
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1. Delete the “public” community and create a read/write community with 
its own name (for example, WFSM) and a manager list containing the IP 
addresses of the Site Manager workstations that need access to the router 
or BNX platform. 

2. Reconfigure the “public” community to be read-only with universal 
access.

See Configuring Routers or Configuring Customer Access and Trunks (BNX 
Software) for instructions on how to perform these two steps. 

Setting Secure Mode

Bay Networks routers or BNX platforms have an optional security mechanism for 
all SNMP SET requests. This proprietary mechanism solves some of SNMP’s 
security problems until a stable, widely accepted, industry-standard security 
solution is available.

When you enable the security mechanism, the router or BNX platform operates in 
secure mode. In secure mode, a Site Manager SET request to the router or BNX 
platform includes the encrypted value of a counter. When the agent on the router 
or BNX platform receives the SET request, it compares the encrypted value with 
the value of its own counter plus one. If the 2 counters match, the agent considers 
the SET request authentic, increments the counter by 2, stores it in an encrypted 
form in the MIB, and sends it back to Site Manager.

The security mechanism protects against these security violations:

• Message stream modification, in which an intruder reorders, delays, or replays 
SET requests to specify unauthorized management settings

• Masquerade operations, in which an intruder assumes the identity of an 
authorized party to specify unauthorized management settings

The security mechanism does not protect against the following security violations, 
which are beyond the scope of our proprietary interim security system:

• Modification of information, in which an intruder intercepts a packet, modifies 
its contents, and reinserts it into the message stream before the agent’s counter 
is incremented

• Disclosure, in which an intruder observes which variables are being set
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Enabling the security mechanism only minimally affects router or BNX platform 
performance. The security mechanism has no effect on the ability of Site 
Manager, or of any SNMP network manager, to monitor the router or BNX 
platform by performing GET, GET-NEXT, or trap functions. You cannot use 
“public,” the default SNMP community, with secure mode. See the prior section 
for instructions on changing the SNMP community. The next section describes the 
procedure for enabling secure mode.

Specifying Secure Mode

Using the Technician Interface, set the router or BNX platform to operate in 
secure mode by completing the following steps:

1. Enter the following command:

wfsnmpmode 3 

3 indicates that the router or BNX platform should operate using the 
proprietary security mechanism.

2. Specify the key that the encryption algorithm uses when it encrypts the 
security counters by entering the following command:

wfsnmpkey   <key>   

<key> is the string of ACSII characters that you select to make up the 
encryption code for this router or BNX platform. Make the key six characters 
or less. 

The encryption algorithm uses the attributes of the key (size, range, and value) 
as integral parts of its encryption process. Also, when Site Manager issues the 
first SET request within an application, you must enter this key as a password 
that enables the Site Manager to operate in secure mode.

See Using Technician Interface Software for more information about using 
the Technician Interface.
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Appendix A
Sample Install.bat Script

To perform the Quick-Start installation procedure on your router or BNX 
platform, run the install.bat script as described in Chapter 6. A typical script 
follows. Your script will vary, depending on your router or BNX platform model 
and network configuration.

------------------------------------------------------------------------

       ####    #   #   #      #   # #### ##### #     #  ##  ###  #  #  ###
       #   #  # #   # #       ##  # #      #   #     # #  # #  # #  # #
       ####  #   #   #        # # # ###    #   #  #  # #  # ###  ##   ###
       #   # #####   #        #  ## #      #   # # # # #  # #  # # #     #
       ####  #   #   #        #   # ####   #    #   #   ##  #  # #  # ###

               ###  #  # ###  ## #  #      ### #####  #   ###  #####
              #   # #  #  #  #   # #      #      #   # #  #  #   #
              #   # #  #  #  #   ##   ### ###    #  #   # ###    #
              # # # #  #  #  #   # #         #   #  ##### #  #   #
               ###  #### ###  ## #  #     ###    #  #   # #  #   #
                  #

                                   Version 1.108
                               Copyright 1993-1996
------------------------------------------------------------------------

                                  Introduction
                                  ------------

This part of the Quick-Start procedure configures the initial IP
network interface on the router. You perform this procedure so that
the router can communicate with the Site Manager workstation.

Each step of this procedure is further described in the
Quick-Start manual. As you perform the procedure, refer to the Quick-
Start manual for additional helpful information and examples.
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When you are finished with this procedure, the router will be able to
communicate with the Site Manager workstation over the IP network. You
are then ready to install Site Manager Software, as described in
Chapter 4 of the Quick-Start Guide.

Each procedure step requires you to do one of the following things:
        1. Enter a number that corresponds to a selection.
        2. Enter 'y' for Yes;  'n' for No; 'q' for Quit.
        3. Enter a word or phrase referred to as a "text string"
        4. Enter <Return> to accept default displayed in [].

You must press the <Return> key after entering one of the above responses.

Press <Return> to Continue, q<Return> to Quit:
------------------------------------------------------------------------

                    Preliminary Information You Need to Know
                    ----------------------------------------

Before you begin this procedure, you should gather the network
information listed below:

You Need to Know This Information:                For Example:
----------------------------------                ------------
Type of Link Module connecting the router's       DSDE
IP network interface to the Site Manager.

Slot number where the Link Module resides.        2

Communication type and connector number           Ethernet XCVR1

IP address of initial IP network interface        192.32.10.189

Subnet mask of initial IP network interface       255.255.255.0

IP address of Site Manager workstation            192.32.10.100

Do you wish to continue? (y/n)[y]:
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------------------------------------------------------------------------

Step 1.  Specify the slot number where the Link Module resides.

                      Slot Menu for Link Module
                      -------------------------

 Slot    Link Module        Processor Module
 ----    -----------        ----------------
    1    SRML               SRMF
    2    QE/NF              FRE2
    3    MCT1-2             FRE2
    4    WF_FDDI_2M         FRE
    5    SYNC-2             FRE

Enter the slot number [2]:

-------------------------------------------------------------------------------
Step 2. Specify the Link Module and network interface information for
        the initial IP connection to the Site Manager.

Link Module: QE/NF

Connector Menu
--------------
1. XCVR1
2. XCVR2
3. XCVR3
4. XCVR4

Enter connector number [1]:

Recommended Circuit Name: E21

Enter circuit name [E21]:
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------------------------------------------------------------------------

Step 3.  Specify the IP configuration information for the network
         interface.

                              IP Configuration Menu
                              ---------------------

 IP address format:          ###.###.###.###

 IP subnetwork mask format:  ###.###.###.###
                    Example: 255.255.255.0

Enter IP address in dotted decimal notation: 192.168.135.100

Enter IP subnetwork mask in dotted decimal notation: 255.255.255.224

Is the router connected to the same local area network as
the Site Manager workstation? (y/n)[n]:

Since the router is not on the same network as the Site
Manager workstation an IP Routing Protocol must be
configured in order to manage the box remotely

               IP Routing Protocol Configuration Menu
               --------------------------------------
               1. RIP
               2. OSPF
               3. Static Route to Site Manager.

Enter Routing Protocol Number [1]:

------------------------------------------------------------------------

                                RIP Configuration
                                -----------------

RIP will listen to a specific route to the network or subnet where
Site Manager is located.  If you also would like RIP to listen
to the default route (0.0.0.0) then answer 'y' below.  The default
route is useful when no specific route is available in the RIP
updates received by this router.

Should RIP listen to the default route? (y/n)[n]:

RIP Configuration Complete
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------------------------------------------------------------------------

                         SNMP Community Management Menu
                         ------------------------------

Setting up SNMP community management is optional.

It allows you to limit control of this router to a single
Site Manager workstation at a given IP address.  The default
is to allow any Site Manager from any workstation to manage
and to configure the router.

Note: You can later configure this using Site Manager.

Do you wish to set SNMP community management? (y/n)[n]:
------------------------------------------------------------------------
Step 4.  Select TFTP default volume.

                            TFTP Default Volume Menu
                            ------------------------

 NVFS File System:

VOL    STATE      TOTAL SIZE    FREE SPACE    CONTIG FREE SPACE
---------------------------------------------------------------
 2:    FORMATTED    4194304        415822           403326

Enter volume number [2]:

TFTP default volume is 2:

------------------------------------------------------------------------
Step 5.  Select FTP default volume.

                                   FTP Menu
                                   --------

Do you want to enable FTP? (y/n)[n]: y

 NVFS File System:

VOL    STATE      TOTAL SIZE    FREE SPACE    CONTIG FREE SPACE
---------------------------------------------------------------
 2:    FORMATTED    4194304        415822           403326

Enter volume number [2]: 2
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FTP default volume is 2:

------------------------------------------------------------------------
Step 6.  Enable TELNET

                   Enable the Technician Interface via TELNET
                   ------------------------------------------

Do you want to enable TI TELNET? (y/n)[n]:

------------------------------------------------------------------------

                              Configuration Summary
                              ---------------------

Link Module:         QE/NF
Connector:           1
Slot:                2
Circuit Name:        E21
IP address:          192.168.135.100
IP subnetwork mask:  255.255.255.224
Routing Protocol:    RIP
Default Rt. Listen:  No
TFTP Default Volume: 2:
FTP Default Volume:  2:
TI TELNET:           No

Press [RETURN] to continue:

------------------------------------------------------------------------
Step 7. Specify a name for the configuration file.

                         Save configuration to a file.
                         -----------------------------

The Quick-Start configuration of the router is now complete and active.

Do you wish to save this configuration to a file? (y/n)[y]:

Default file name is startup.cfg on the current volume.

NOTE: Do *NOT* name this file 'config'. Later, you may wish to rename
      this file 'config' after you perform a named boot and verify its
      operation.

Enter file name [startup.cfg]:
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Sample Install.bat Script
------------------------------------------------------------------------
Step 8.  Test this initial IP interface configuration.

                                TEST IP Interface
                                -----------------

IP Interface 192.168.135.100 is up.

Testing local IP interface.

ping -IP 192.168.135.100 -r5
IP ping: 192.168.135.100 is alive (size = 16 bytes)
IP ping: 192.168.135.100 is alive (size = 16 bytes)
IP ping: 192.168.135.100 is alive (size = 16 bytes)
IP ping: 192.168.135.100 is alive (size = 16 bytes)
IP ping: 192.168.135.100 is alive (size = 16 bytes)

This test attempts to ping the Site Manager workstation.

NOTE:  If routing has not yet converged, an attempt
       to ping the Site Manager workstation may fail.  If
       this happens, you may either enter a new IP address or
       quit and wait a short period of time and try again from
       the TI command line.

Type q<return> to cancel this test.

Enter IP address of Site Manager workstation: q

Exiting...
  More Mode: ON
  Lines per screen: 24

[2:1]$
A-7





Appendix B
Sample TCP/IP Stack and NIC Driver Installation

This appendix describes a test installation of Distinct TCP/IP and a NIC driver on 
a PC, presented here as an example only. Your installation steps will vary 
depending on the PC, network interface card, and network you use. Refer to the 
Distinct Corporation and network-interface card documentation for more details.

To install Distinct TCP/IP, it was necessary to:

1. Obtain the latest NDIS driver for our Ethernet network interface card. 

The first time we performed Steps 2 to 14, we received a message that Distinct 
does not supply the needed driver for our network-interface card. Distinct 
does supply a driver for many cards, but sometimes you may have to use the 
driver supplied with the card or obtain the latest update. 

We made an FTP connection to the manufacturer and downloaded the latest 
driver (elnk3.dos) to a disk that we used in step 15.

Similarly, if you install a driver and get the message “Bind failed,” you may 
have to update the driver software that came with your card. 

2. Remove interfering network management software.

Because we wanted to test a new installation, we eliminated interference from 
an old version of Distinct and other networking software on our test computer 
by

• Deleting the old Distinct directory

• Making backup copies of the autoexec.bat and config.sys files
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• Editing the autoexec.bat and config.sys files to delete references to the old 
version of Distinct and the other networking software. 

3. Roboot the PC.

4. Enter win to start Windows.

5. Insert the Distinct installation disk in the disk drive.

6. Select File➔Run.

7. Enter A:\setup and run Distinct.

8. Accept the default to “Add Library to Path.”

9. Accept defaults for the destinations for the program and driver.

10. Accept defaults to create the directories for the program and drivers.

The program then copied files from the disk to the created directories.

11. Enter the Distinct serial number and key code from Table 7-1 in 
Chapter 7

12. Accept the prompt to select and set up a network interface card. 

Skip this step if you already have a NIC installed or if you are using SLIP or 
PPP over a modem.

13. From the Choose Adapter menu, choose the EtherLink III (3C509B) card 
that was installed in the PC.

14. Select the NDIS driver type as opposed to Packet or ODI type.

15. Copy the driver from the disk when prompted to supply a location for the 
card driver. 

16. Click on OK on the request to update the autoexec.bat. config.sys, and 
protocol.ini files.

17. Choose to define a host instead of dynamically defining it using the 
BOOTP or RARP protocols.

18. Define our host’s Name and Internet Address (192.---.---.---). 

19. Choose not to enter a Domain Server Name.

20. Choose to enter a Default Server Gateway.

Note: You can only run one TCP/IP stack at a time.
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21. Define our Gateway Name and Internet Address.

22. Choose not to set up a serial line IP (SLIP or PPP).

23. Reboot the PC.

The Distinct TCP/IP and network interface card driver installation succeeded.
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creating a pilot configuration file, 11-1

.cshrc file, editing, 8-4

customer support. See getting help

D
data bits, 3-2
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circuit name, 11-9
files, 6-3
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dir command, 6-2, 6-6

Distinct TCP/IP
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troubleshooting, 7-8
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editing .cshrc file, 8-4, 9-4, 10-3

enhancing pilot configuration file, 11-15
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F
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Frame Relay worksheet information, 2-5
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G
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installing Site Manager, 10-2
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system requirements, 10-1
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initial IP configuration file, 6-8

initializing the router, 6-4

installation files, 6-3

installation script
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running, 6-5
sample, A-1

installing Site Manager
on a PC, 7-9
on a SPARCstation, 8-2
on an HP 9000, 10-2
on an RS/6000, 9-3
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address, 6-9, 11-11
Configuration window, 11-11
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stacks, 7-1
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loading Site Manager

on a PC, 7-9
on a SPARCstation, 8-2
on an HP 9000, 10-2
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M
Manager command, 5-1
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modules in ASN, 1-2
Index-2



Motif, switching to Version 1.1.4, 9-2
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NetView/6000 implementation notes, 9-7
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NIC driver
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installing Site Manager on, 7-1
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pilot configuration
adding, 11-7
creating, 11-1
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implementing, 11-13

ports, 4-1, 11-7

PPP worksheet information, 2-5

prerequisites for Quick-Start, 1-1 to 1-4

protocols, enabling on a circuit, 11-10

Q
Quick-Start

installation script, 6-5, A-1
overview, 1-1
prerequisite steps, 1-1 to 1-4
troubleshooting, 6-9

R
read/write access, restricting, 11-15

rebooting a router, 11-13

restricting read/write access, 11-15

RIP configuration worksheet information, 2-3

route verifying, 6-9

router cabling, 4-1

router network connection example, 2-3

router software images, 6-4

routers with Quick-Start procedures, 1-1

RS/6000
installing Site Manager on, 9-1
operating with NetView/6000, 9-7
system requirements, 9-1

S
sample router configuration, 11-1

securing Site Manager, 11-15

Select Protocols window, 11-11

services file, editing, 7-12

setting up Site Manager users, 8-3, 9-4, 10-3

show ip circuits command, 6-9

show ip routes command, 6-9

Site Manager
default circuit name, 11-9
setting up users, 8-3, 9-4, 10-3
starting

from OpenView, 8-8, 10-6
from SunNet Manager, 8-7, 9-7
on a PC, 7-12
on a SPARCstation, 8-5
on an HP 9000, 10-4
on an RS/6000, 9-5
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SMDS worksheet information, 2-6
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installing Site Manager on, 8-1
operating with NetView/6000, 8-8
system requirements, 8-1
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displaying default files, 6-3
locating the volume, 6-2
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SPARCstation, 8-1

T
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terminal settings. See console operating 
parameters
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adding a well-known service, 7-12
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ti.cfg file, booting with, 6-4

troubleshooting
Distinct, 7-8
Quick-Start installation, 6-9

V
verifying

Site Manager environment, 8-5, 9-5, 10-4
Site Manager installation

on a SPARCstation, 8-5
on an HP 9000, 10-4
on an RS/6000, 9-5

VME routers and the backplane command, 5-2
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W
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wfchkinst command, 8-5, 9-5, 10-4

wfsm command, 8-6, 9-6, 10-4

Windows program group, creating, 7-11

Windows Sockets, 7-1

windows, Site Manager, 7-13, 8-6, 9-6, 10-5, 
11-4

worksheet
Distinct configuration, 7-5
network information, 2-1 to 2-6

World Wide Web, Bay Networks Home Page on, 
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